


[bookmark: _Hlk56163031]The Power of JAWS!
#JAWSTip 1: Using Voice Schemes 
I was recently asked by a friend if he could tell when something was highlighted in Microsoft Word. I recommended using Schemes. 
· Open a Word document
· Press INSERT+ALT+S and JAWS should say Select a Scheme 
· You will have a list of Voice Schemes and be highlighted on Word Classic 
· Type “Colors” to move to that scheme and press ENTER
Once back in the document you can start reading. JAWS will announce when the colors of the text or background changes. 
Remember to set your Scheme back to Word Classic once you are finished. 
You can see a short video of this feature at https://www.youtube.com/watch?v=8eCf4z_esBo&t=27s 
The Power of JAWS!
To learn more: follow @FreedomSci on twitter, ask your smart speaker to play the Freedom Scientific Training podcast or subscribe to the Freedom Scientific Training You Tube channel.


#JAWSTip 2: Navigation of the Outlook Inbox like a table 
By Default, JAWS reads the highlighted item in your Inbox as you move up and down through your emails. Let's say that you know the Subject of the email and don't want to be bothered by hearing who it was from, importance, if it has an attachment, etc. 
All you need to do is use the Table Layered Command of INSERT+SPACE followed by the letter “T”. 
Now you can move through the different columns of an email. Once you move to Subject, you can then press down arrow to move down the subjects of your Inbox. 
Once you find the email you are interested in you can press ENTER and your email will be opened. You will notice the tone indicating Table Layered Mode is now off. 
You can also use CTRL+ALT+ARROW keys to move left or right on an email in your Inbox without running Table layered Mode. This will not work for moving up and down. 
Note this works on any folder containing emails. 
The Power of JAWS!


JAWS Tip 3: Customize Outlook Message List
I was reminded by  a customer about JAWS having a feature that allows a user to customize what JAWS speaks when you navigate the Outlook Inbox. 
Right now by default JAWS will say the following items in this order unless you have reordered the columns in your Inbox. 
Importance, Reminder, Icon, Attachment, From, Subject, Received, Size, Categories, Mention, Flag Status
Now if you are like me, I don't know and don't care about most of this stuff. and if I cared, I don't want to hear Attachment before I hear From and Subject. And who really cares about size any more. Once it is in your Inbox isn't it too late to worry about size? 
So, you don't need to change things in Outlook, you can just have JAWS do it for you. 
Press INSERT+F2, choose "Customize Outlook Message List" 
Once in this dialog you can use the Tab key to move through the dialog. Note that you will start on the Speech Tab, you can switch to the Braille Tab by pressing Right Arrow when on the Speech Tab.
The first section of the dialog lists all of the fields. You can press SPACEBAR on any item to Mute it. This is a toggle. Next you can move the items up or down the list to change the order it is spoken. You can also have headers spoken, or change what is spoken in place of the header. 
The Power of JAWS!


#JAWSTip 4: Using Temporary Place Markers to Copy, Cut, Delete or just about anything you want.
Ryan Jones, formerly from the Freedom Scientific Training Department and now with TPG a sister company of Freedom Scientific, reminded me the power of JAWS Temporary Place Markers. 
I will not be able to give all of the commands for this feature, but you can look them up with Command Search. To get to Command Search you can press INSERT+SPACE followed by the letter “J”. Now type in the word “Mark” followed by pressing TAB.
We have all been faced with the need to select text. Sometimes we have found this difficult because we do not know if it has selected everything or did it select an extra space. Then when we went to paste it we found we had a mess in the document. 
· Put your cursor where you want to begin selecting text
· Press CTRL+WINDOWS KEY+K to set a Temporary Place Marker
· Move to the end of what you want to select and press INSERT+SPACE followed by the letter “M”
· You should hear that JAWS has selected your text
· Now you can do whatever you planned with that text
This works in text editors like Word and Notepad, browsers like Chrome and the new Microsoft Edge, and probably some other places where I haven’t tried this. 😊
https://youtu.be/UqiKYjvVK6Y
The Power of JAWS!


JAWS Tip 5: Create Row and Column Headers for Ranges that Read Automatically for JAWS Users
I was talking with a colleague who needed to create a Microsoft Excel file that he wanted to have it accessible. He did a nice job making sure that columns had headings, but JAWS did not read them without me telling JAWS. Now it is great that JAWS has the ability for the user to set Title Reading for Excel files, but it is much nicer if our companies would add the reading of the headings automatically. Check out this page from the Microsoft Excel with JAWS training. 
https://doccenter.freedomscientific.com/doccenter/doccenter/rs25c51746a0cc/2013-09-25_ExcelAndWordHeaders/02_HeadersInExcel.htm
The Power of JAWS!
To learn more: follow @FreedomSci on twitter, ask your smart speaker to play the Freedom Scientific Training podcast or subscribe to the Freedom Scientific Training You Tube channel.



JAWS Tip 6: Lock your keyboard with JAWS 
When you need to make sure you don’t accidentally type something like when you are on a call or just got up from your desk to get a drink, you may want to lock your keyboard. This is not like locking your computer, it is only stopping you from doing something destructive. 
· Press INSERT+SPACE followed by the letter “L”
· This is a toggle 
The Power of JAWS! 
To learn more: follow @FreedomSci on twitter, ask your smart speaker to play the Freedom Scientific Training podcast or subscribe to the Freedom Scientific Training You Tube channel.



JAWS Tip 7: Finding running spaces and Font Changes
JAWS has a feature called Text Analyzer. You can use Insert+Space followed by the letter "A" to turn this on. It is a toggle. 
Once on, JAWS will announce running spaces, font changes, etc. You can also use Alt+Windows Key+I to move the cursor to the next inconsistency found by Text Analyzer, and announces or indicates the type of inconsistency found. 
Also available in Fusion.
https://www.youtube.com/watch?v=wfs6dDBcrhg
The Power of JAWS!


Updating JAWS Tip 8: Append Selected Text to Clipboard with JAWS
· Select text with the SHIFT key 
· Copy text to the Freedom Clipboard with INSERT+WINDOWS+C 
· Perform the steps above until you have copied everything 
· Use INSERT+SPACE followed by the letter “C” to view the Freedom Clipboard 
· Use CTRL+V to paste the Freedom Clipboard 
· Pressing CTRL+C will prompt you to replace the items in the Freedom Clipboard with the new items 
Note that you lose any formatting with the Freedom Clipboard.
Check this out on YouTube https://www.youtube.com/watch?v=b6WnDBOQiVw&feature=youtu.be
The Power of JAWS!



Updating JAWS Tip 9: Using the Skim Reading Tool 
Back in JAWS Tip 1 I showed how to have JAWS announce the color of the text using the Voice Schemes. The Skim Reading Tool is a more powerful way to complete this task. 
In the previous method the person would need to read the entire document and pay attention to everything JAWS said. 
The Skim Reading Tool will allow you to collect a list of everything that is highlighted in Yellow and then allow you to choose which one you wanted to view. You can find the Skim Reading Tool in the JAWS Managers list under Insert+F2. Try looking for either colors or font attributes. Once you go through the wizard you will want to use the button called Create Summary Button. 
You can read about this at https://www.freedomscientific.com/SurfsUp/Skim_Reading.htm
And watch the video at https://www.youtube.com/watch?v=Xb73D5c6Vak&t=47s
The Power of JAWS!


JAWS Tip 10: Is JAWS Not Speaking As You Move Your Cursor? 
In almost all applications moving the cursor or caret using your arrow keys causes JAWS (or any screen reader) to speak the character, word or line as you use the appropriate cursor movement commands.  This works nearly 100% of the time. However, I recently noticed that JAWS wasn’t speaking as I was moving the cursor in Jarte, a Wordpad-like word processor that I often use. This was baffling until I found the fix. 
If you encounter this problem in Jarte or in any program where cursor navigation isn’t speaking try toggling enhanced edit support. 
· Press INSERT+F2 for the list of JAWS managers and press ENTER on Settings Center
· You may be asked to create a new configuration 
· In the search edit field type “edit” without the quotes
· Navigate with the down arrow key through the list of results and look for “enhanced edit support”
· While this should be enabled for Word it should be disabled for Jarte
· Press the SPACEBAR to toggle this setting 
· Press ENTER twice to save your settings 
Thanks David Goldfield
The Power of JAWS!
Subscribe to the Freedom Scientific Training YouTube channel and join the JAWS Software f/t Blind club on Clubhouse.



Updating JAWS Tip 11: Identifying the address of a link 
Did you know that you could check the address of a link with JAWS. The reason for doing this is that emails and webpages may have links that may not be safe, otherwise known as phishing links. 
· Once in an email or webpage press INSERT+F7 
· Locate the link 
· Press INSERT+PAGE DOWN 
· JAWS will announce the address of the link 
In the latest JAWS 2021 release from February 2021 you don’t need to use List Links INSERT+F7 to check the address.
· Press TAB or just arrow to a link 
· Press INSERT+CTRL+F7 to have JAWS announce the address of the link 
· Press it twice quickly to open the Virtual Viewer with the address 
· Alternatively, once on the link you can press INSERT+F1 to open the Virtual Viewer to have JAWS announce the address of the link and allow you to use standard reading commands 
This feature also works in Fusion.
The Power of JAWS! 
https://www.youtube.com/watch?v=l1nFM3tBpPU&t=88s 


JAWS Tip 12: Using Speech on Demand 
There are times when you just need JAWS to shut up. It may be when you are in a meeting and you keep hearing JAWS read notifications. Now there are many places where you can adjust notifications, but you may also just want to quickly mute speech. Try the key combination Insert+Space followed by the letter S. This is a toggle command. This allows you to mute speech unless you ask JAWS through a reading command to speak. 
Now, did you know you could customize this feature? You can go to Settings Center with Insert+Number Row 6. Now search for "Speech on Demand." Arrow down to that choice and press F6 to see the different options. 
You may want JAWS to totally mute or allow for mouse echo. Just Tab through the settings to see the different options. 
Once complete you can press F6 followed by Enter twice to save your settings. 
Note that you can set settings by application or for Default settings. 
The Power of JAWS!


JAWS Tip 13: Adjusting Page Refresh 
Turning off Page Refresh Automatically in the quick settings was a very helpful tip for saving time. It keeps pages you interact with in Google Chrome from repositioning the cursor at the top of the page each time you select certain elements. 
To turn it off: Press Insert V inside Chrome. Type refresh into the search box. Arrow down twice. The second option is called General Options Personalize Web Settings, and when you spacebar enough times it will toggle that off. You then have to tab to ok and enter. 
Thanks Garrett Mosley.
The Power of JAWS!


JAWS Tip 14: Confused by the keystrokes scheme for Focus Braille displays? 
Here's the short version: Windows command use the left shift key, Braille commands use chorded commands or the spacebar key, and JAWS commands use the right shift key. Following that rule gets you a good understanding of most keystrokes So left shift with v (dots 1 2 3 6) is the Windows paste command. Right shift with the same dots is the QuickSettings dialog think JAWSKey+V. 
The Power of JAWS!


JAWS Tip 15: OCR Directly to Microsoft Word in JAWS and Fusion 2021 
The Convenient OCR (Optical Character Recognition) feature has been enhanced to support sending recognized text directly to Word. Convenient OCR enables you to access images containing text that is part of the image and displays this information in the Results Viewer. This includes onscreen images such as the graphical setup screen for an application, an inaccessible PDF opened in Adobe Reader, a currently selected image file in Windows Explorer, or a document acquired by the PEARL camera or a flatbed scanner.
If Microsoft Office is installed on your system, you can now:
Use the new command INSERT+SPACEBAR, O followed by R to perform OCR on a selected image file in File Explorer or the Desktop and place the recognized text directly into a Word document. You can also press the APPLICATIONS key and choose Convenient OCR to Word with JAWS or Fusion from the context menu.
Use the new Open in Word link that appears at the bottom of the Results Viewer once the OCR process is complete.
For more information about using Convenient OCR, press INSERT+SPACEBAR, O followed by QUESTION MARK or refer to the Convenient OCR topic in the JAWS help.
The Power of JAWS!
[bookmark: _Hlk56846651]

Updating JAWS Tip 16: JAWS Settings for Specific Webpages 
Let’s say you don’t want a specific webpage to start reading when the page loads, but you want all other pages to read automatically. 
· Go to the webpage 
· Press INSERT+6 on the number row to open Settings Center 
· Press CTRL+SHIFT+W to change from settings for the browser to settings for this webpage 
· Type in the word “Document” and arrow down. You will hear “Document and Web Pages Automatically Read When Loaded Checked” 
· Press SPACEBAR to uncheck the setting followed by the ENTER key twice
· Press F5 to refresh the page
When you create settings for specific pages it will carry from browser to browser. 
The Power of JAWS!
https://www.youtube.com/watch?v=XpIMYofUisU



Updating #JAWSTip 17: Using Default Settings 
If you ever run into an issue where JAWS is not saying or doing what you expect it to do, you may want to run JAWS with default settings to make sure you have not changed a setting that is impacting you. In the past you would have unloaded JAWS, opened the “Run” dialog and typed in “JAWS18 /default” and press Enter. This is challenging for some people because you are typing in a command with no speech. 
This command still works today, but a solution was added a few years back to make it easier for users to perform the switch. 
· Press INSERT+SPACE followed by the letter “Z” 
· This is a toggle 
Note: This will switch to desktop layout for your keyboard.
https://www.youtube.com/watch?v=x3Bfia-9V3U 
The Power of JAWS!
Subscribe to the Freedom Scientific Training YouTube channel and join the JAWS Software f/t Blind club on Clubhouse.


JAWS Tip 18: Announcing document headers and footers 
Have you ever wanted to know if a document has a header or footer?  In the past I have used Insert+F1 when a document opens. The problem is that I would have to do this on each page. This is very time consuming. You can change a setting in Quick Settings to have these announced automatically. 
1. Open Microsoft Word 
2. Press Insert+V for Quick Settings 
3. Type the word “Header” 
4. Arrow down to “Header and Footer Detection  not checked”‑ 

This option controls whether JAWS detects and announces headers and footers in the current section of the currently opened document.
The default setting is Off.
when the option is on, as a document opens, JAWS announces the presence of headers and footers in the current section of the document.
If the option for Page, Section, And Multiple Column Breaks is set to on, the presence of headers and footers in a section will be announced when the section
change is announced.
The Power of JAWS!


Updating #JAWSTip 19: Reversing Last Setting 
One cool feature of JAWS is that you can see recent settings you have changed. 
· Open Settings Center with INSERT+Num Row 6 
· Press TAB into the Tree View 
· Press the END key and JAWS will say “Last Changed Settings”
· Arrow to the right to expand the Tree View and arrow down to view recent setting changes 
https://www.youtube.com/watch?v=TyQfuwbZgDc 
The Power of JAWS!
Subscribe to the Freedom Scientific Training YouTube channel and join the JAWS Software f/t Blind club on Clubhouse.


Updating #JAWSTip 20: Adjusting the JAWS Volume on the Fly 
Have you ever been in a virtual meeting or listening to a You Tube video and you really want to adjust the volume of JAWS. In the past you had to move to the volume icon in the system tray and adjust the JAWS volume control. Now with JAWS 2021 you can do this on the fly.
· Press INSERT+SPACE followed by the letter V for volume 
· Now use the letter J for adjusting the JAWS volume 
· Next use UP ARROW to increase the volume and DOWN ARROW to decrease the volume 
· You can also adjust the system volume by using the letter S instead of J 
· Use PAGE UP and PAGE DOWN to adjust in larger increments 
Also checkout #JAWSTip 37 and 38.
Also available in Fusion.
The Power of JAWS!
https://www.youtube.com/watch?v=c9AK9igXzZw 


JAWS Tip 21: Select a Microphone to Use with Voice Assistant
Microphone Input Device is a new Voice Assistant setting. It shows all available microphones on your computer (for example, an internal microphone and a connected headset) and lets you choose which microphone Voice Assistant uses when listening for commands. By designating a different microphone for this feature than what is being used for other applications such as Teams or Zoom, it allows you to mute the microphone in those applications during meetings and still use the Voice Assistant with JAWS. 
· Open the JAWS menu and Go to Utilities 
· Press Enter on Voice Assistant sub menu‑ 
Choose Settings… and Settings Center will open to Default settings for all applications 
· You will be in the Tree view and focused on Voice Assistant
Arrow down to Microphone Input Device Windows and you will hear the name of the microphone that is selected 
· You can use the SPACEBAR to change the microphone 
· Press TAB to the Ok Button and press ENTER 
Note this feature is available in Fusion and ZoomText under the Voice Assistant Settings. 
The Power of JAWS!


JAWS Tip 22: Virtualize Current Control 
You ever find areas where you can not read something by character or word? This is usually because the text is part of an element such as a chat message in Skype or Teams. 
· Locate the element 
· Press INSERT+SHIFT+V 
· JAWS will load the text that was spoken into the Virtual Viewer 
· Once you have read the text you can press ESCAPE
Note this does not work in a Browser while using the Virtual Cursor and this also works with Fusion.
The Power of JAWS!


JAWS Tip 23: Labeling a Web Element 
You ever go to a page where the label on a button is wrong or just too wordy? You ever want to change the label of a link so that it is easier to find? 
JAWS has a “Create Prompt” feature. Think of this as a custom label for something that is not labeled correctly. 
0. Go to www.disneyplus.com 
0. Choose the Login link 
0. Type in your email address and choose the “Agree and Continue” button 
0. Type in your Password and press TAB and you will hear an unlabeled button
0. Press INSERT+CTRL+TAB and you will be prompted to enter a new label 
0. Type in “Show / Hide Password” and press ENTER
You have now given a new label for the button. 
Note: This is not a pass for a website to not properly label a button, but a way to assist the JAWS user in using the site while we need to continue to encourage companies to meet the accessibility standards. 
The Power of JAWS!


JAWS Tip 24: Shorten JAWS Messages without having to Skip Valuable Information
To stop JAWS from talking too much, you might have just set the speech verbosity to intermediate or advanced. However, what happens then is check boxes are cleared so information does not speak. Maybe you want it to speak, but just not to ramble. You can shorten the messages to the "TL/DR" version: 
· Open Settings Center with INSERT+6 on the number row 
· Press CTRL+SHIFT+D to load the Default settings 
· Type in “Speech Verbosity” and press DOWN ARROW to select it 
· Next press F6 to move to the configuration page 
· Select the radio button for the desired verbosity followed by pressing TAB to the button to configure your settings 
You'll find yourself in a list of check boxes so you could customize what gets spoken. Just tab once to the "JAWS Message Length" radio buttons group and select the one you want. This will change how JAWS handles all messages that are allowed at your verbosity level. Changing from Long to Short but still using Beginner Verbosity alerts you to everything, but saves time. 
The Power of JAWS!


JAWS Tip 25: JAWS Command Search 
You don’t know the command for reading a table in Microsoft Word, you don’t know how to OCR a document or you don’t know how to make a grilled cheese? Well, maybe not grilled cheese, but we can add that as a feature enhancement, you should learn how to use “Command Search” in JAWS and Fusion.
Pretty simple, press INSERT+SPACE followed by the letter j. Now type in anything you want JAWS to do. Well, maybe not anything. 
Examples, the word “table”, “append” or “Say All”. 
You will then press TAB and magic will happen.   
You will now be presented with commands based on your search. 
Just TAB forward and you will hear different commands. You can Press ENTER to submit a command. 
Just press Escape to leave the search window. 
The Power of JAWS!


JAWS Tip 26: Moving to the Tab Control in a Browser 
I have noticed that many users navigate a page by using the TAB key, some use Links List INSERT+F7 and others just arrow down through the page. Of course there are many ways to navigate a page in a browser including H for Headings and R for Regions. Then you hit a page that uses different types of controls and you are not sure what to do. It is almost like opening the refrigerator and you find some food that you cannot identify, is it meat or is it cake? 
One of these controls is a tab control. I am not speaking about the browser tabs or the TAB key. You cannot use INSERT+F7 to find a tab control, but you can use a Navigation Quick Key. 
· Go to You Tube 
· Press the Navigation Quick Key ‘ (apostrophe) to move forward by Tab 
· Add SHIFT to move backwards 
The Power of JAWS!


JAWS Tip 27: Setting a PlaceMarker on a Webpage 
Back in JAWS Tip 4 I explained how to use Temporary PlaceMarkers to select and copy text. Now let’s see how we can use PlaceMarkers to make it easier to go to controls on a webpage. This would be something you plan to do frequently, like searching on You Tube within a channel or posting in a Facebook group. Yes, in both of these examples you could just hit the letter “B” until you hear the button you are looking for, but in the case of You Tube the Search Button within the channel is the 11th button on my computer. In the case of this Facebook group the “What’s on your mind, Matt? Button” is the 9th button.
· Load a page with a button you want to save as a PlaceMarker
· Locate the button using the letter “B”
· Once you are on the button you can press CTRL+SHIFT+K
· JAWS will say “PlaceMarker List  dialog, PlaceMarker List view” followed by the name of any PlaceMarkers you have set 
· Press TAB to move to the Add Button and press ENTER
· You will be prompted FOR a name, weather you want the PlaceMarker to work on all pages in the domain/website and if you want to use the text of the button so that JAWS can find the PlaceMarker even if the location moves on the webpage
· Use the TAB to move through the dialog and choose Ok once you are done
· You will return to the webpage 
· The letter “K” and SHIFT+K will move between PlaceMarkers on a webpage 
· The PlaceMarker dialog will allow you to add, remove and change any of your PlaceMarkers 
Make sure you check out “Custom PlaceMarker Page Summary” on https://www.freedomscientific.com/SurfsUp/PlaceMarkers.htm. This feature is very powerful. 
This feature works in Fusion as well. 
The Power of JAWS!


JAWS Tip 28: Getting Help from JAWS 
My goal is to provide you all the ways you can get help from JAWS. I hope that I don’t miss anything. If I do, please share and I will update the post. 
JAWS Help in the Application 
You can always get help in the application under the Help menu. The method for getting to the Help menu depends on how you bring up JAWS. 
· Press INSERT+J 
· If JAWS opens the application window you can now press ALT+H for the Help menu 
· If JAWS opens in the System Tray you will be able to just press the letter “H” 
· This menu contains Command Search, Training, JAWS Help Topics, Keyboard Commands, What’s New, etc.
Command Search 
I covered this in JAWS Tip 26. It is a great feature designed to help you find a command. It gives you the commands based on which application you are running when you use it. 
· Press INSERT+SPACE followed by the letter “J” 
· Type in your topic you want to search 
· Press TAB to see the first result and press TAB again until you find what you are looking for 
· Press ENTER on the item you want and the command will be activated 
Keyboard Help 
If you want to know what a key does in JAWS you can turn this mode on. 
· Press INSERT+1 on the number row 
· This is a toggle 
· Press any command or key to learn what it does 
· Press it twice quickly for more information 
Hotkey Help 
Use this feature to get a list of JAWS specific hotkeys for the active application. 
· Press INSERT+H 
· The list of commands will be presented in the Virtual Viewer 
· Use your arrow keys or TAB key to read the hotkeys 
· Use the ENTER key to activate a command 
· Use ESCAPE to exit the Virtual Viewer and return to your application 
Windows and Application Hotkey Help 
Windows and applications like Microsoft Word and browsers have many hotkeys. You can use this feature to get a list of commands for that application. Not all commands are listed and it is possible that the application has changed a hotkey. 
· Press INSERT+W 
· The list of commands will be presented in the Virtual Viewer 
· Use your arrow keys to read the hotkeys 
· Use ESCAPE to exit the Virtual Viewer and return to your application
Application Specific Help 
There are two ways to get help on Windows or a specific application such as Microsoft Word or a browser. 
· Press INSERT+F1 when you need help 
· JAWS will load the Virtual Viewer with specific help for where you are at the time you press the command 
· Try using it at the top of a document or webpage vs. using it in an edit field or button on a webpage 
· Press ESCAPE when you are finished 
If Freedom Scientific has written a help topic on a specific application you can use this feature to read the help topic. This is easier than searching the help system because it automatically goes to the application section in Help.
· While in the application press INSERT+F1 twice quickly 
· Once in Help press F6 to move to the topic and use your standard reading commands 
Ask Sharky or Zoomy 
The Voice Assistant in JAWS and Fusion is there to help users do common tasks within JAWS and Fusion. The commands and features supported will continue to grow over time. Just say the wake word or press the keystroke and ask Sharky or Zoomy for Help. 
· Wake word for JAWS is Sharky 
· Hotkey to start Sharky is INSERT+ALT+SPACE 
To learn more: follow @FreedomSci on twitter, ask your smart speaker to play the Freedom Scientific Training podcast or subscribe to the Freedom Scientific Training You Tube channel. 
More tips like these can be found in the FB group JAWS Users. 



JAWS Tip 29: Desktop vs. Laptop Keyboard Setting 
What is the real difference between Keyboard Layouts, Desktop and Laptop? And why might I consider using Laptop Layout, even though I like to use a full keyboard plugged into the laptop most of the time?
JAWS offers a couple of different layouts for a good reason. Many people use laptops which do not have a Numeric Keypad. Most users know, this numpad is the Speech Pad you use for various Screen Reading commands in conjunction with the INSERT Key, when the numlock key is off. So, when you are on a laptop, the laptop layout allows you to use the CAPSLOCK key as the JAWS key in conjunction with various letters from your right hand for screen reading like you would on the numpad. So CAPSLOCK+ K, is SayWord and CAPSLOCK+I is the say line command. If you turn on keyboard Help with CAPSLOCK+1 on the number row, you will get Keyboard Help and you can get familiar with the rest of the commands.
Now, many laptop users might also connect a full keyboard. So, JAWS, provides all the desktop layout commands to also work when a numpad is present. So you get the best of both worlds while in laptop layout. For those of us who are using it both with and without the Numpad, setting the layout to laptop, and getting use to CAPSLOCK as an option also, is a great solution.
The Power of JAWS!
To learn more: follow @FreedomSci on twitter, ask your smart speaker to play the Freedom Scientific Training podcast or subscribe to the Freedom Scientific Training You Tube channel.


JAWS Tip 30: What is Wrong with the Letter G
I have seen several posts on different lists where people have run into a problem when typing the letter “g”. No, this is not a virus. 
Windows has a feature called the Game Bar. The hotkey for launching the Game Bar is WINDOWS+G. It is possible that the Windows key may be stuck and need to be tapped a few times to ensure it is not sticking. Alternatively you can turn the Game Bar off. 
· Press WINDOWS+I to launch Windows settings 
· Type in “Game Bar” and press DOWN ARROW until you hear “Enable Xbox Game Bar”
· Press TAB key until you hear the description of the Game Bar 
· Enable Xbox Game Bar for things like recording game clips, chatting with friends, and receiving game invites. (Some games require Xbox Game Bar for receiving game invites.
· Use SPACEBAR to toggle this setting to “Off”
To learn more: follow @FreedomSci on twitter, ask your smart speaker to play the Freedom Scientific Training podcast or subscribe to the Freedom Scientific Training You Tube channel.


JAWS Tip 31: Using the Word List Command 
You have all kinds of options to find something on a webpage or in a document. You can use JAWS Find, you could create PlaceMarkers on a webpage or in a document, but something I have grown to love is the Word List command. 
· Open a webpage or document 
· Press INSERT+CTRL+W 
· Type the first couple of letters of a word that you expect to be on the webpage or in the document 
· If the word appears it will be highlighted and if there is multiple occurrences of the word then a number will appear after the word
· Press ENTER on the word and you will move to the first occurrence of the word 
· If on a webpage you can press the letter “W” to find the next occurrence of the word 
· If in a document you will need to toggle on Quick Keys before pressing the letter “W”
I have found this helpful on webpages like Facebook. If you want to find the word “JAWS” or “Groups” it is easier than pressing TAB.
The Power of JAWS!


JAWS Tip 32: Speech on Demand 
The long lost tip 32. Thanks to Adam Lawrence for keeping me in line and thanks to Clubhouse for suggesting Tip 32. 
Have you ever wanted to mute JAWS while in a Zoom or Teams meeting? You may also want to type for a while and not hear any interruptions of chats, announcements, etc. Maybe you just want to use Braille without speech for a while.
· Press INSERT+SPACE followed by “S”
· Use reading commands like INSERT+UP ARROW to read current line 
· Use other reading commands 
· Once complete, do it again to toggle it off 
· Add SHIFT to do a full mute 
Search for Speech on Demand in Settings Center to adjust settings.
This is also available in Fusion.
The Power of JAWS!




JAWS Tip 33: Using the @ Mention in Microsoft Outlook and Teams 
One of the cool features of Office 365 is the @ mention command. This is the way you can get others either added to the conversation or get their attention. Using this feature will alert the person mentioned that they have been tagged. This is very useful when writing a post in a Teams channel. This will ensure the person mentioned is notified even if they don’t have notifications turned on in that channel. 
When responding to an email in Microsoft Outlook you can just type @ symbol followed by the persons name. JAWS will announce the number of people found and put focus on the first person found. You can press Enter on the name of the person you want to add to the email. They will be added to the “To:” field of the Reply message. 
When writing a chat or post in a channel in Teams you can use the @ mention command to mention only people who are part of that chat or channel. Similar to Outlook you can just type the @ symbol followed by the person’s name. Press Enter on the name you want to mention. 
Thanks to @MSFTEnable #A11y
Search other Tips on JAWS, ZoomText, Fusion, Office and Teams.
The Power of JAWS!


JAWS Tip 34: Personalizing Web Settings
You can configure many JAWS settings for specific Web sites. Personalized settings apply to all pages of a given domain, such as CNN dot com or Freedom Scientific dot com.
1. Open the browser and go to the webpage where the settings will be used. 
2. Press INSERT+V to open the Quick Settings dialog box. Focus is in the Search edit box.
3. Press DOWN ARROW to move to the Quick Settings tree view.
4. Press P to move to the Personalize Web Settings group. If necessary, press RIGHT ARROW to expand the group.
5. Press DOWN ARROW to move to the different options and groups within Personalize Web Settings, and press SPACEBAR to make changes.
6. After making all necessary changes, press TAB to move to the OK button and then press SPACEBAR to save changes and exit Quick Settings.
Happy browsing!
The Power of JAWS!
To learn more: follow @FreedomSci on twitter, ask your smart speaker to play the Freedom Scientific Training podcast or subscribe to the Freedom Scientific Training You Tube channel.


JAWS Tip 35: Where did that Table Go?
We made a change In JAWS 2021 the way tables are detected on webpages. Below is a transcript from FSCast where Glen Gordon discusses a Power Tip. 
GLEN: Time now for this month’s Power Tip. It comes to us from Bernhard Stöger in Austria, related to tables on the web. I wonder if you’ve ever seen a website where you’re pretty sure the data is laid out in a table, but JAWS doesn’t identify it as such. This could be for a couple of reasons. But one reason might be that JAWS thinks that this is a table used exclusively for layout, and so we figure there’s no purpose in announcing it to you. And the way you can kind of decide if that’s the case is to turn on layout tables. It’s an option that’s available in Settings Center or in Quick Settings. Search for “layout,” and you’ll see that option. That’s the way it’s always been with JAWS up until 2021.
But with JAWS 2021, there’s a new wrinkle. And that is that we change the way we decide if something is a data table. It used to be that we made our own decisions based on an algorithm that we developed over time. It worked pretty well, overall. But people have mentioned to us that it’s a little disconcerting to have different screen readers finding different tables on pages. And so we decided that we’d start using the browser’s determination of whether or not the table is used for layout. That, too, works pretty well.
But as of JAWS 2021, since that’s the new default, you may find that there are websites where you don’t see tables where you previously did. And there’s a new option, and that’s the one I want to highlight for you. 
1. Go to a webpage with a table that JAWS doesn’t see 
2. Press INSERT+V for Quick Settings 
3. Type “Layout” and you will hear that JAWS found 3 items 
4. Arrow DOWN to the 3rd option “JAWS determines if a table is for layout purposes only, not checked”
5. Use your SPACEBAR to turn this option on 
6. TAB to Ok and press ENTER 
Checkout FSCast https://blog.freedomscientific.com/fscast/
The Power of JAWS!


#JAWSTip 36: Copy Speech History to the Clipboard 
One of the cool features of JAWS is the Speech History.  This feature as of JAWS 2021 will show the last 500 things JAWS said. 
· Press INSERT+SPACE followed by the letter “H”
· This will open the Results Viewer 
· Use your ARROW keys to navigate the Speech History 
· Use your selection keys to select text and copy it to the clipboard 
· Press INSERT+SPACE followed by SHIFT+H to clear the Speech History 
A new command I learned this week is you can copy the Speech History. 
· Press INSERT+SPACE followed by CTRL+H to copy the current Speech History to the clipboard  
The Power of JAWS!
Subscribe to the Freedom Scientific Training YouTube channel and join the JAWS Software f/t Blind club on Clubhouse.


#JAWSTip 37: Creating a Voice Profile 
This tip will be a prerequisite for #JAWSTip 38 coming up next. 
A cool feature of JAWS is that you can have a different voice for different cursors or applications. For example, maybe you like Tom for Microsoft Word and Ava for Microsoft Outlook. Maybe you like punctuation in Microsoft Word, but not in Google Chrome. This is all handled through Voice Profiles. 
· Open the JAWS menu with INSERT+J 
· Go to Options, Voices, Voice Adjustment… 
· Select the voice you want to adjust and press TAB to explore the dialog 
· When finished choose the Save As Button and give it a unique name followed by Ok 
· You will now be asked if you want to use this as the Default Voice Profile 
· Choose No 
· Go to the application where you want to use the new Voice Profile 
· Press INSERT+CTRL+S and select your new Voice Profile 
· This dialog has two list boxes, 1 for Default and the other for the current application 
· Press TAB to move to the listbox for the current application and choose your new Voice Profile 
· Press TAB and choose Ok 
Now you will be set when #JAWSTip 38 is revealed. 
This feature is also available in Fusion.
The Power of JAWS!
Subscribe to the Freedom Scientific Training YouTube channel and join the JAWS Software f/t Blind club on Clubhouse.
Check out the Great Dan Clark in this YouTube video.
https://www.youtube.com/watch?v=N5aYLPEFaSI&t=16s


#JAWSTip 38: Setting your JAWS Volume for a Specific Application 
This tip assumes you have read #JAWSTips 20 and 37. Tip 20 dealt with adjusting JAWS volume on the fly and Tip 37 dealt with creating a JAWS Voice Profile.
Wouldn’t it be nice to set your JAWS Volume specific to an application like Zoom? Well, you can do just that. You will need a JAWS Voice Profile that you want to use with Zoom. 
· Load the application 
· Press INSERT+CTRL+S to select a Voice Profile 
· Press TAB to the listbox for the current application 
· Select the application 
· Press TAB and choose Ok 
· Now adjust the JAWS volume with INSERT+SPACE followed by the letters “V” for Volume and “J” for JAWS 
This also works in Fusion.
The Power of JAWS!
Subscribe to the Freedom Scientific Training YouTube channel and join the JAWS Software f/t Blind club on Clubhouse.


#JAWSTip 39: Turning On and Off Announcements of Grammatical Errors
Starting in the JAWS and Fusion 2021 April update, the Grammar and Advanced Proofing feature is on by default except in MS Word and Outlook. This change will only impact the applications that check for grammatical errors. For example, within web browsers such as Firefox, Chrome, and Microsoft Edge, online editing tools such as Google Docs can detect grammatical errors. This feature is always on in Google Docs, so JAWS will announce the grammatical errors that Google Docs detects.
Note that online editors are not as good at detecting grammatical errors as applications such as MS Word. The efficiency of grammatical error detection may also be impacted by the internet connection and the server used for checking them.
In MS Word and Outlook, JAWS and Fusion will not announce grammatical errors by default. The Grammar and Advanced Proofing feature is turned off in the JAWS Settings Center. And in MS Word, the Mark grammar errors as you type feature is off by default. Both options would need to be turned on for JAWS to announce grammatical errors. Instructions are in the solution below. But keep in mind that since MS Word does a good job at detecting grammatical errors, the announcement of each error while listening to a Word document could be quite distracting
1. Open the JAWS menu > Utilities > Settings Center. (INSERT+J opens the JAWS menu.)
1. In the Application combo box, select either Default (All applications) or select the application you want to change.
1. In the search edit box, type grammar.
1. Navigate to the Grammar and Advanced Proofing option, then press the SPACEBAR to toggle it.
1. Select the OK button.
Turning grammar detection on or off in Microsoft Word (it is off by default):
1. Open MS Word.
1. Open File > Options -> Proofing.
1. Navigate to the Mark grammar errors as you type checkbox, then press the SPACEBAR to toggle it.
1. Select the OK button.
The Power of JAWS!
Subscribe to the Freedom Scientific Training YouTube channel and join the JAWS Software f/t Blind club on Clubhouse.


#JAWSTip 40: Spellcheck in Word with JAWS 
I have never been a fan of spell check in Microsoft Word. You can always use F7 and move through the dialog. Let’s look at two alternatives to F7.
· Open a document with spelling mistakes 
· Press INSERT+Z to toggle on Quick Keys in JAWS 
· Press the letter “M” to move to the spelling error 
· You will hear JAWS say the word, spell the word and read the sentence 
· Press APPLICATIONS key or SHIFT+F10 to open the context menu and select the appropriate spelling 
You will be back in the document and Quick Keys will be turned off. Follow the steps above until you don’t hear any more spelling errors.
Alternatively you can use a feature in Word to practically do the same. 
· Press ALT+F7 
· You will be moved to the first spelling error and the context menu will automatically open 
· Select the appropriate word and you will return to the document 
· Follow the steps above until you hear that you don’t have any more spelling errors 
This is available in Fusion and Microsoft Outlook.
The Power of JAWS!
Subscribe to the Freedom Scientific Training YouTube channel and join the JAWS Software f/t Blind club on Clubhouse.



#JAWSTip 41: Using Braille Study Mode On-the-Fly
Braille Study mode can be a great help, especially for those learning to read contracted braille. Braille Study mode will speak the name of a single braille character or one-cell contraction, or it can be made to spell an entire word, helping you identify one and two cell part-word and whole word signs.
Braille Study mode can be turned on and off from within JAWS Settings Center, but it is much handier to use “on-the-fly” when you encounter a contracted braille symbol, part or whole word contraction that you need help figuring out.
To use Braille Study Mode on the fly using the Focus 40 Blue or Focus 14 Blue braille display, do one of the following:
· Press the NAV MODE button plus the CURSOR ROUTER button above the braille character  to make JAWS identify the braille character in question
· Press either SELECTOR button plus a CURSOR ROUTER button above a word to make JAWS announce and spell the braille word.
If you don’t know the name of certain keys on the Focus display or what they do you can use keyboard help mode. 
· Press Insert+1 on the number row to toggle this mode 
The Power of JAWS!
Subscribe to the Freedom Scientific Training YouTube channel and join the JAWS Software f/t Blind club on Clubhouse.


#JAWSTip 42: I Did Not Hear That 
You ever been working along either typing or reading something and a notification is announced, and you were not focused on that notification. You may have stepped away or maybe you were on the phone. The key is you missed what JAWS said. 
· Press INSERT+SPACE followed by the letter “N”
· JAWS will speak the last notification 
Also available in Fusion.
The Power of JAWS!
Subscribe to the Freedom Scientific Training YouTube channel and join the JAWS Software f/t Blind club on Clubhouse.



#JAWSTip 43: That Did Not Sound Right 
You ever hear a word that did not sound right or just want an abbreviation spoken correctly. JAWS has a Dictionary where you can create custom pronunciations or use a sound for a specific word or phrase.
· Locate the word or phrase that you want to change 
· If a phrase you will need to select the text using a method for selection 
· Press INSERT+D to launch the JAWS Dictionary Manager
· If you want the pronunciation to apply to all programs press CTRL+SHIFT+D, otherwise it will only apply to the current application
· Press ENTER on the “Add” button 
· JAWS will say “Actual Word: Edit”
· If you don’t see the current word or phrase you want to fix you will need to type it in 
· Use the TAB key to explore the rest of the dialog 
· Choose “Ok” button when finished 
· Now press ALT+F4 to close the JAWS Dictionary Manager 
· You will be prompted to save the file 
This is also available in Fusion.
The Power of JAWS!



#JAWSTip 44: Virtualize It!
Back in JAWSTip 22 I covered Virtualize Current Control, then I covered Speech History in JAWSTip 36. These are two very valuable features of JAWS. The challenge with these commands is there are more commands and keystrokes to remember. When do you do Insert+Shift, Insert+Space or just Insert. Well, there are two great options to solve this problem. 
Command Search 
· INSERT+SPACE followed by the letter “J”
· Type in your search and press TAB until you hear what you are looking for and press ENTER
Voice Assistant 
· For Speech History commands 
· Hey Sharky Clear History
· Hey Sharky Copy History 
· For Virtualizing commands  
· Hey Sharky Virtualize Window 
· Hey Sharky Virtualize Control 
· Hey Sharky Virtualize It 
Try other options with Sharky and let us know how it is going.
The Power of JAWS!
Join us on Monday at 10 am EST on Clubhouse to chat JAWS tips and answer your questions. 



